Installation Instructions for Students (September 2018)

These are the instructions for installing LeJOS and Eclipse onto your computer for use in the course. The
instructions are for Windows 10 users. If you are using a Mac or a Linux laptop, you will need to look at the
wiki page of the www.lejos.org website for further instructions ... which will bring you to the sourceforge
website: http://sourceforge.net/p/lejos/wiki/Installing leJOS/ It is assumed for the remainder of this document
that you are using a laptop running Microsoft Windows.

1. Download and install the x86 version of the “older” Java SE Development Kit 7 JDK (DO NOT
DOWNLOAD THE x64 VERSION, although with Mac OS X there is only a 64-bit version. Also, make
sure NOT to download the JRE ... you need the JDK). Also, do not download version 8 as it does not
yet work on the EV3. When this was written, the latest was jdk-7u80-windows-i586.exe for windows)
from this website: http://www.oracle.com/technetwork/java/javase/downloads/java-archive-downloads-
javase7-521261.html. Once you click download, you will be redirected to a login page. Create an oracle
account and login to continue. You will need to go to the bottom of the page to Java Archive and press
the Download button. Select Java SE 7 from the list. Select Java SE Development Kit 7u80. Accept
the licence agreement and then select the Windows x86 version which is jdk-7u80-windows-
i586.exe. You will be redirected to a login page. Create an account and login to complete the
download.

2. As eclipse (the IDE we will be using for this course) requires java 1.8+, repeat the steps above for jdk-
8ul181-windows-i586. (DO NOT DOWNLOAD THE x64 VERSION, although with Mac OS X there is

only a 64-bit version. Also, make sure NOT to download the JRE ... you need the JDK). This can be
found here: http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html.

3. Download the 0.9.1-beta version of the 1eJOS windows installer from
https://sourceforge.net/projects/ev3.lejos.p/files/ and run it (for Windows, the file is called
leJOS_EV3_0.9.1-beta_win32_setup.exe. Follow the instructions to select the java jdk version that
you installed in step 1. Note that the program will automatically go to the Program Files folder on the
C drive. You will have to back up and go to the Program Files (x86) folder to find the version that you
just installed. Allow the remaining default options during the setup ... which will create a leJOS EV3
folder in the C:\Program Files folder. Once installed, it will have a checkbox to Launch the
EV3SDCard utility. Uncheck this because | have already prepared the micro SD cards for you and
will give them to you on the first day of class (or possibly sooner if | see you).

4. Eclipse will be used as the IDE for the course. Download Eclipse from this website
http://www.eclipse.org/downloads/eclipse-packages/. You will want the Eclipse IDE for Java
Developers (usually the forth option in the list). Make sure to download the Windows 32-bit version
(NOT THE 64-BIT VERSION). At the time this was written the file was called: eclipse-java-photon-R-
win32.zip. Unzip the file after it downloads. If any errors pop up when unzipping ... just “skip” those
files. A folder should have been created with the same name. It is a good idea to drag this folder to
the C:\Program Files (x86) folder. Inside the folder is an eclipse folder and inside there you should
see a purple circle icon ... this is the eclipse application. Right-click on it and select Create shortcut.
Drag the shortcut to your desktop and rename it to Eclipse. Double-click to run it. It will ask you to
create a workspace ... enter this C:\Users\Mark Lanthier\ COMP2801 (of course, your username will
be different) You can close the "welcome" screen.
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5. From the Help menu, select Eclipse Marketplace.... Under the Search tab, type in lejos EV3 into the
Find: textbox and press ENTER. The leJOS EV3 Plug-In should appear at the top. Press the Install
button. Accept the licence agreement and press Finish. Click Install anyway when the Warning
dialog box pops up. Go ahead and restart Eclipse when it asks you. Once Eclipse has restarted, the
plugin should be available and you will see a menu item called 1eJOS EV3 as well as a couple of
orange leJOS icons.

6. Now we need confirm that EV3_HOME is set properly in the preferences. Click the Window menu and
select preferences and then 1eJOS EV3 in the list on the left-hand side. You should set the
EV3_HOME to your installed folder location (likely C:\Program Files\leJOS EV3) if it has not been set
yet. Make sure that Run Tools in separate JVM is selected as well as Run program after upload.
Check off Connect to named brick and enter 10.0.1.1 into the text field labelled Name. Press the
Apply and Close button.

~

Turn on your EV3 at this time. It typically takes a good minute or so for the EV3 to boot up. In fact,
the very first time that you turn on the EV3 with the micro SD card, it will take a good 8 minutes or so to
initialize everything!

8. Now we will get a Hello World program running on the robot. All code in Eclipse is organized into
Projects. Once eclipse has started, go to the File menu and select New and then Project... (i.e. NOT
Java Project). Select the LeJOS EV3 folder and then LeJOS EV3 Project and press Next >. Enter
COMP2801 as the Project name at the top. Under JRE, change “Use an execution environment JRE”
to JavaSE-1.7. Make sure to do this every time you create a new project. Then click the Finish button.
You should see the COMP2801 project appear in the workspace under the Package Explorer on the
left side of the window.

9. Select the COMP2801 project (from the Package Explorer) that you just made. Select File/New/Class
from the menu bar. Type HelloWorld into the Name: field (with no spaces) of the resulting window.
Select the checkbox that says public static void main(String[] args). Click Einish. The new class
should appear.

10. Adjust code to look as shown here:

import lejos.hardware.Button;
public class HelloWorld {
public static void main(String[] args) throws Exception {
System.out.println ("Hello World") ;
Button.waitForAnyPress () ;

}

11. If there are any syntax errors, then will be shown with an (x] along the left side of the code:

[J] *HelloWorld.java &2

_1 import lejos.hardware.Button;

public class Hellokorld {
public static woid main(String[] args) throws Exception {

|Sj,.rr1tax error, insert ;" to complete BlockStatern entsrl
Button.waltFordnyPress();




Fix any syntax errors before continuing and then save your code by pressing the save button "=
(or press CTRL + S).

12. Once your code compiles and saves ok, we can run it. Make sure that the EV3 is turned on and that it

13.

is not currently running a program. Connect the EV3 to your laptop using the USB cable provided in

the kit. In Eclipse, press the run button > to upload your program onto the robot and run it. The first

time you do this for each program, it will ask how you want to run the program. Select LeJOS EV3
Program and press OK.

If the upload did not work, you will get a message like this in the bottom Console pane of Eclipse:

(% Problems @ Javadoc |2, Declaration B Console 33

lelO5 EV3

Par file has been created successfully

Using the EV3 menu for upload and to execute program

Creating the jar file or upleoading the program failed

java.rmi.ConnectException: Connection refused to host: 18.8.1.1; nested exception is:
java.net.ConnectException: Connection timed out: connect

Caused by java.net.ConnectException: Connection timed out: connect

See Eclipse error log for detailed stack trace.

If this happens, it is likely because the EV3 just booted up and there was not enough time for the USB
port to be initialized ... takes up to a minute or so. You can try again ... or perhaps just unplug the
USB cable and plug it back in again, then wait for 30 seconds.

Hopefully, the program will load and run on the robot. Note that it takes a bit of time for the program to
start up. If it worked, you should see the following in the bottom Console pane of Eclipse:

& Console 53
lelO5 EV3

Jar file has been created successfully

Using the EW3 menu for upload and to execute program
Uploading to 18.8.1.1 ...

Program has been uploaded

Running program ...

leJos EV3 plugin launch complete

You should also see the words Hello World appear on the EV3. Press any button on the EV3 to quit
the program.

If you get an Exception when you try to run your code ... assuming that you did not have any typos ...
the problem is likely that Eclipse has defaulted your project to use the latest version of JAVA instead of
version 1.7. To fix this, right-click on your COMP2801 project on the left side panel. Select the Build
Path submenu and then select Configure Build Path ... at the bottom of the menu. On the left side of
the dialog box, select Java Compiler. Unselect the checkbox under the JDK Compliance section that
says "Use compliance from execution environment ...". For the Compiler compliance level:,
select 1.7 from the drop down list. Press Apply and then OK. Hopefully, the code will run now.

Unplug the USB cable ... we will try to get it working with the Bluetooth. On the EV3, use the left and
right buttons on the menu to scroll until it says Bluetooth ... with the bluetooth icon centered. Select it
by pressing the center dark gray button. Make sure that the EV3 is visible by scrolling to Visibility (i.e.,
the eye icon). It should say Visibility on, otherwise press the dark gray button to turn it on.



14. In the taskbar of windows, off to the right,
you should see something like this under
the hidden icons. Select the Bluetooth
icon as shown here circled:

Now select Add a Bluetooth Device
from the popup menu that appears:

Hopefully, the EV3 will appear in the list

bluetooth devices. If not, double check that the Visibility is
enabled on the EV3. Select the EV3 and press Pair:

<« Settings

€03  DEVICES

Printers & scanners
Connected devices
Bluetooth

Mouse & touchpad
Typing

AutoPlay

USB

[ ] Add a Bluetooth Device
W AT Allow a Device to Connect
pad ﬂ Show Bluetooth Devices

Send a File
Customize... Receive a File

( Join a Personal Area Metwork
Open Settings

Remowve lcon

Find a setting e

Manage Bluetooth devices

Your PC is searching for and can be discovered by Bluetooth
devices.

Paired

E'D EV3
Ready to pair

Logitech® diNovo Edge™

Pair

Related settings
More Bluetooth options

Send or receive files via Bluetooth

15. It will try to confirm the device that you are connected to. The pairing code should be 1234 (although
you can confirm this on the EV3 by pressing the right arrow so that the key icon appears and then
press the dark grey button to go in and change it).



Enter the passcode for your device

Enter the passcode for your device

You can find the passcode on your EV3 or in the info that came with 1t

Make sure to do this when no other EV3 devices are around. Thatis ... don't try doing this in the lab
when everyone has their EV3 on, otherwise you may be pairing up with someone else !!! Do it at
home. Press Next. It should say that it is installing device driver software. Hopefully you see this:

&« Settings — O ®

€03  DEVICES Find a setting Jo

Printers & scanners .
Manage Bluetooth devices

LT EETE HE TR Your PC is searching for and can be discovered by Bluetooth
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Mouse & touchpad ED EV3
Paired
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Paired

AutoPlay



16. Now we must create a PAN (Personal Area Network). In Windows 10, go to the Start menu and select
Settings. Select Network and Internet. Select Ethernet on the left side. Select Network and
Sharing Center on the right. Select Change adapter settings on the left. Select Bluetooth
Network Connection. On the toolbar, select View Bluetooth network devices. Select the EV3 icon.
Select Connect using on the toolbar and then choose Access point.

oH Devices and Printers

A+ e « Devi.. » Bluetooth Perso.., v & | Search Device.. 0
Add a device Add a printer Connect using » = v 0
Access point

~ Unspecified (1)

—

EV3

EV3 Model Bluetooth Peripheral Device
Category: Other
Status:  Paired

You should see this:

Bluetooth Network Connection
9 Connecting....

The connection should then be made. You should now be able to upload your programs using
bluetooth. Try to run your program again (make sure that the USB cable is unplugged).

If you get an error message similar to “IP Address is null Brick 10.0.1.1 not found” in eclipse when
running a program, consult this troubleshooting guide:

https://jira.iais.fraunhofer.de/wiki/display/ORInfo/EV3+%28leJOS%29+driver+installation+under+Windo
ws+8%2C+10

Each time that you turn on your EV3, you will need to repeat this
last step to connect the access point.
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